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System Requirements
Potato Face for Macintosh requires MacOS 10.4 or later.  Potato Face for Windows requires 
Windows XP or later.

A color monitor of 1024 x 768 pixels or larger is required. Potato Face resizes itself to fit your 
monitor, so the higher resolution you have, the sharper the picture will be.

Installation
Macintosh
To install Potato Face on a Macintosh, insert the CD in the drive.  Double-click the installer icon 
to begin the process.  The installer places the Potato Face files inside the Marblesoft folder in 
your Applications folder.  It will create a Marblesoft folder if none exists, and it will create an 
alias on your desktop. You can drag the alias to your Dock if you prefer.

Windows
To install Potato Face on Windows, insert the CD in the drive.  The installer should start 
automatically.  If you have turned off the auto-start feature, double-click the SETUP.EXE icon to 
begin the process.  The installer places the Potato Face files inside the Marblesoft folder in your 
Program Files folder.  It will create a Marblesoft folder if none exists, and it will add Potato Face 
and the User’s Guide to your Start menu.

What’s on the CD
In addition to the Potato Face program, the installer places several PDF files in your Potato Face 
folder.  PDF files can be opened Adobe Reader, which is most likely already installed on your 
computer.  If you don’t have Reader, you can download it from www.adobe.com/reader.

Read Me First
Read Me First is a file containing the minimum information you need to get Potato Face up and 
running.

Potato Face User’s Guide
This document, which contains everything you need to know about Potato Face.

Potato Face Coloring Book
The Potato Face Coloring Book is a printable coloring book of faces in various states of 
completion.
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Potato Face Communication Board
The communication board is a printable set of control panels for an individual learner or two 
in a two-player cooperative activity. Used in print form, the learner can point and reference 
the communication targets or the communication board can be cut apart to exchange the 
communication targets. Used in interactive form, it works especially well with a touch screen or 
interactive whiteboard in individual or small group activities and instructional lessons.

Running the Program
Macintosh
To launch Potato Face, double-click the icon on your desktop, or click the icon in your Dock.  If 
you have deleted these aliases, or if you’re launching the program from a different user account, 
open your Applications folder, then the Marblesoft folder, then the Potato Face folder.  Double 
click the Potato Face icon to start the program.

Windows
To launch Potato Face, select it from the Marblesoft folder in the Start menu.  If you have 
deleted this shortcut, open your Program Files folder, then the Marblesoft folder, then the Potato 
Face folder.  Double click the Potato Face icon to start the program.

The Potato Face Kid
Each activity in Potato Face displays one or two “faces” which are really heads with shoulders 
and sometimes hands.  In this manual, we’ll refer to the visible body as a “face”, and all the 
features, clothes and accessories as its “parts”.  The user manipulates the faces by using icons 
placed along the bottom of the screen.  Each icon represents a single body part, and the user 
clicks on the icon to change that part on the face.

You can specify the default sex and skin color for the face (see Settings - Default Sex and 
Default Skin Color on page 18).  If you leave the sex set to random, the program will randomly 
alternate between boy hair and girl hair.  If you leave the skin color set to All Skin Colors, the 
program will default to the last skin color the user selected.
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Menus
The program’s menu bar is hidden by default. To show the menu bar, press the “ESC” key to 
return to the main menu screen. Press ESC again to hide or show the menu bar. All the program 
settings and features can be controlled from the menu bar.  You can also use keyboard shortcuts 
to access most menu items, even when the menu bar is hidden.

Potato Face Menu (Mac only)
Use Potato Face Menu to set preferences or to quit the program. 

File Menu (Windows only)
Use the File Menu to quit the program. 

Edit Menu
Use the Edit menu to copy and paste in a dialog.  On Windows, use the Edit menu to set 
preferences.

Activity Menu
Use the Activity menu to select an activity to play.  
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The Main Menu
After a short introduction, the Potato Face main menu screen will appear.  The main menu is the 
command center of the program.  From the main menu screen, you can select any of the Potato 
Face activities by clicking on their name.   

You can return to the main menu screen at any time by pressing the “ESC” key.  Press ESC again 
to show or hide the menu bar.

Click on the “Settings” icon to bring up the Settings dialog.  See Settings on page 15 for a 
complete description of the program settings.

Click the “Quit” icon to quit Potato Face.  You can also quit the program at any time by 
choosing Quit from the menu bar, or by typing (Mac: ⌘-Q or Win: Ctrl+Q).  On Windows, you 
can also quit the program using the standard Alt+F4.
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The Activities
The following pages describe the five Potato Face activities.

Cause and Effect
The Cause and Effect activity presents the child with a boy or girl of the specified (or random) 
skin color (see Settings - Default Sex and Default Skin Color on page 18 for a description of how 
sex and skin color works in Potato Face.)

Each time the child hits the switch, a different expression is shown, with an appropriate 
animation or sound effect.  If an optional second switch (see Settings - Second Switch Repeats 
Expression) is pressed, the animation and sound effects for the same expression are repeated.

You can jump directly to the Cause and Effect activity from any other activity by typing 
(Mac: ⌘-1 or Win: Ctrl+1).
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Funny Face
Funny Face is a progressive cause and effect activity that allows kids to make funny faces. The 
program starts with a blank outline of a head. When the child presses a key or switch, the head 
is filled in with a random skin color according to the preference you have specified (see Settings 
- Default Skin Color). Each time the child presses a key or switch, the next body part is added, 
until the funny face is complete. 

With the dozens of features included in Potato Face, there are literally millions of combinations, 
so each funny face you create will be unique.  

You can jump directly to the Funny Face activity from any other activity by typing (Mac: ⌘-2 or 
Win: Ctrl+2).
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Potato Face
The Potato Face activity allows the child to play with body parts and accessories in a fun 
computer version of the classic game you remember as a child.  The program starts with a head 
of the specified skin color.  By clicking on an icon, the child can choose a different skin color.  

Note:  If a default skin color is specified in the Settings dialog, there will be no skin color choices 
in Potato Face.

After the skin is chosen, the player is presented with a variety of hair styles, starting with the 
default style for the specified sex (see Settings - Default Sex). The player changes the hair styles 
by clicking the hair icon. Hair styles are followed by eyes, nose, mouth, shirt color, hats and 
accessories, rings and nails, and finally glasses and moustaches.

When the Fewer Choices option is on (see Settings - Number of Each Body Part to Show), the 
really wacky body parts are not displayed, leaving the child with only the realistic choices.

You can jump directly to the Potato Face activity from any other activity by typing (Mac: ⌘-3 or 
Win: Ctrl+3).
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Make a Face
The Make a Face activity offers the player a way to experiment with different facial part 
combinations in a freestyle manner.  A boy or girl is presented on the screen (see Settings - 
Default Sex and Default Skin Color) with a row of icons for changing the body parts.  Choosing 
the hair icon will change the hair color, the eyes icon will change the eyes, and so on for the 
nose, mouth and skin color.   

Note:  If a default skin color is specified in the Settings dialog, there will be no skin color choices 
in Make a Face.

The child can experiment with different combinations as long as they like. When they are 
satisfied with a face, they can select the OK icon.  Their program will congratulate them on their 
face and prompt them to try another face.

Make a Face doesn’t include the strange body parts, only the realistic ones.  When the Fewer 
Choices option is on (see Settings - Number of Each Body Part to Show), their will be a smaller 
number of parts in each category from which to choose.

You can jump directly to the Make a Face activity from any other activity by typing 
(Mac: ⌘-4 or Win: Ctrl+4).
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My Face
My Face is an activity that uses the same interface as Make a Face, except that the child is asked 
to make a specific face.   

The program starts by asking the child to make their own face.  When they are satisfied, the child 
chooses “OK” to signal their satisfaction. The program will congratulate them and ask them to 
create a friend’s face. Each time the player completes a face, the program asks them to create a 
new, specific face.

You can jump directly to the My Face activity from any other activity by typing (Mac: ⌘-5 or 
Win: Ctrl+5).
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Face to Face
In Face to Face, the program creates a random face on the left half of the screen.  The student 
then creates the matching face on the right, using the row of icons at the bottom of the screen, 
similar to the ones used in Make a Face and in My Face.   

When the student has created a matching face, they choose “OK”, and the program tells them 
whether or not they are correct.  If incorrect, the program prompts for another try.  If correct, the 
program presents a different random face to match.

You can jump directly to the Face to Face activity from any other activity by typing 
(Mac: ⌘-6 or Win: Ctrl+6).
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Settings
The Settings dialog allows you to set all the optional settings in Potato Face.  The Settings 
dialog is automatically opened the first time you run Potato Face. You can also open the Settings 
dialog by clicking the “Settings” icon on the main menu.  You can also open it at any time by 
typing (Mac: ⌘-K or Win: Ctrl+K). A dialog something like this one will appear (this example 
is from the Macintosh version):

The Potato Face settings are described in detail on the following pages.

Direct Selection
Direct selection allows the user to directly choose an item with a keyboard, mouse or other 
pointing device.  

Mouse
Direct selection with a mouse, touchscreen or similar device is the fastest for those players who 
can use it.  Simply click on an item to select it.

Arrow Keys
The arrow keys can also be used when direct selection is on.  When the arrow keys check box is 
on, a rectangle marks the current cursor position.  Use the arrow keys to move the rectangle right 
or left.  When the rectangle marks the desired item, press RETURN or ENTER to select it.
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Scanning
In scanning mode, the computer will scan all possible choices for the student.  The student 
selects a choice by pressing one or more switches.

Select the number of switches, type of scanning, and the scan rate (for timed scanning). The 
player can use one, two or three switches to control the program.

There are many different ways that Potato Face can be set to scan. It may take some 
experimentation to determine the best method for each student.

With timed scanning (sometimes called “auto scanning”), the computer scans the available 
choices at the scan rate you have chosen.  With step scanning, the student uses two or more 
switches to scan the choices and make a selection.  Potato Face offers several variations on each 
of these methods.

One Switch Timed Auto-Scan
When using a single switch for timed auto-scanning, the computer will scan at the rate specified 
in the Settings dialog.  The student uses the switch to select the current choice.  

One switch timed auto-scanning is the most tedious of scan methods, and can be frustrating for 
a student who can handle more than one switch.  One switch scanning is best for students too 
young to understand two switch scanning, or those who are only capable of accessing a single 
switch.

For one switch scanning, configure your switch interface to send a mouse click, space bar, 
RETURN character, number “1” or letter “Y” when the switch is pressed. The same keys on the 
keyboard can also be used as “switches”.

Two Switch Step Scanning
When using two switch scanning, the first switch selects the current item, just like with one 
switch scanning, and the second switch causes the program to scan. The student uses the two 
switches to step through and select a choice (the scan rate does not apply). Two switch step 
scanning is the easiest way for switch users to use the program.

For two switch scanning, configure your switch interface to send a mouse click, RETURN 
character, number “1” or letter “Y” when switch #1 is pressed. Configure your switch interface to 
send a right-click, space bar, TAB character, number “2” or letter “N” when switch #2 is pressed. 
The same keys on the keyboard can also be used as “switches”.
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Three Switch Step Scanning
With three switch scanning, the student uses an optional third switch to scan in reverse. As 
before, switch #2 scans to the next choice, and switch #1 selects the choice, and the scan rate 
does not apply.  

Three switch scanning is the fastest way for an accomplished switch user to use the program.

For three switch scanning, configure your switch interface to send a mouse click, RETURN 
character, number “1” or letter “Y” when switch #1 is pressed. Configure the interface to send a 
right-click, space character or number “2” or letter “N” when switch #2 is pressed. Configure the 
switch interface to send a TAB character or number “3” when switch #3 is pressed.

Flashing Cursor
When the “Flashing cursor” button is on, the scanning cursor flashes once per second.  This 
makes it easier for the student to see the cursor, especially when using letter scanning.

Solid Cursor
When the “Solid cursor” button is on, the cursor doesn’t flash at all, but always remains on the 
screen.  There are two main reasons for using this option.  First, if the student is distracted by the 
flashing of the cursor, you can turn it solid.  Second, if the scan rate is set very fast, like 1 or 2 
seconds, it can sometimes be easier to follow with a solid cursor.

Scan Sound
The scan sound is the sound that is to be played when the program scans to a different choice, 
either automatically for one-switch scanning, or when the user scans manually.

Click Sound

The click sound is the sound that is played when the user makes a selection, either by clicking 
the mouse, pressing a key, or pressing the select switch.

Play Background Music

Check this box off to turn off the music that normally plays in the background.
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Screen Colors

The colors options control the colors that Potato Face uses to draw the background, the wall in 
front of the body, the text, and the rectangle that highlights the screen items when scanning or 
using the arrow keys. Click on a color swatch to bring up a standard color picker.  Choose the 
new color you want for that item.

Highlight Width

The highlight width setting controls the thickness of the rectangle that’s drawn around items 
when scanning and when using the arrow keys.

Default Sex
The default sex setting allows you to specify the default sex of the child on the screen. New faces 
will be drawn with the default hair style for that sex.  This setting does not limit the available 
choices to that sex, only the first hairstyle drawn. The child still has full control of all the body 
parts.

Default Skin Color
When a default skin color is chosen, all faces will be drawn in that color, and there will be no 
options for the child to change the skin color.  When All Skin Colors is checked, Potato Face 
remembers the last skin color chosen by the student, and uses that color as the default.  The full 
selection of skin colors is available to be chosen.  That way, a student is not frustrated by always 
being presented with a face of a different color.  If they choose a certain color for a face, that 
color will remain the default until they choose a different color.
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Number of Each Body Part to Show

When More Choices is selected, all body parts for the current activity are available to the user. 
When Fewer Choices is selected, a smaller number of parts are made available, simplifying the 
program to avoid confusing or frustrating the user.

In the Potato Face activity, Fewer Choices removes all the crazy stuff like lizard skin and button 
eyes, but does not limit the number of realistic parts available to the user.

Cause and Effect Activity
These options apply only to the Cause and Effect activity.

Second Switch Repeats Expression
When this option is on, a second switch can be used in the Cause and Effect activity to repeat 
the current expression.  Configure your switch interface just like you would for two switch 
step scanning. When this setting is off, any switch will cause the program to display the next 
expression.

Show Expression Names
When this option is on, text describing the expression will be drawn at the bottom of the screen.

Randomize Expressions
This check box controls whether the expressions in Cause and Effect are displayed in the same 
order every time or in a random order.

Default Settings
Click this button to restore all Potato Face settings to their default values. 
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Tech Support
Contact Marblesoft Technical Support if you have problems installing or running Potato Face.

Marblesoft Technical Support 
12301 Central Ave NE 
Suite 205 
Blaine, MN 55434

Phone
763-502-0440 

e-mail 
support@marblesoft.com.






